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ESSENTIAL KURZWEIL 3000 SKILLS
(Version 9)

1.  The Kurzweil 3000 Tool Bars
➔ There are four tool bars on the Kurzweil 3000 screen.  These tool bars contain 

icons that offer convenient access to the functions and features of the program.

Main Tool Bar

Reading Tool Bar

Study Skills Tool Bar

Writing Tool Bar

➔ All four of the tool bars can be shown on the screen at the same time. 
Alternatively, all four can be hidden.  Any of the tool bars may be open on its 
own, or in combination with any of the others.  With unneeded tool bars closed, 
you have more work space available on the screen.

The following illustration shows all four of the Kurzweil 3000 tool bars open, with 
the Menu Bar above them.  (Kurzweil 3000 functions can also be accessed by 
the menus.)
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➔ If you want to close a tool bar, or open one that is closed, position the cursor 
anywhere in the blank gray space to the right of the icons on any tool bar, or on 
the gray space to the right of the menus on the Menu Bar.  Right-click the 
mouse, and this will open the dialog box shown below on the right.

        Right-click mouse here.

➔ To close the Reading and/or the Writing Tool bar, click on the check mark 
beside Reading and/or Writing to “de-select” it.   If you want to open the Reading 
and/or the Writing Tool bar, you click beside “Reading” or “Writing” to select it.

➔ For the Main Tool bar and the Study Skills Tool bar, you have three options—
large icons, small icons, or no tool bar at all.  In the illustration below, large icons 
have been selected for the Main Tool bar

➔ It is possible to customize each of the tool bars by removing icons that are not 
needed or by adding other icons.  Customizing tool bars is NOT essential for 
effective use of Kurzweil 3000, so this skill will not be addressed here.

NOTE:  For almost every function, Kurzweil 3000 offers several ways of 
accomplishing a task.  This guide describes only one easy way of getting 
the job done!

2



2.  Scanning Teacher Prepared Material (worksheets, tests, forms) 

➔ Make sure your scanner is connected to the computer before opening Kurzweil 
3000.

➔ Open Kurzweil 3000. 
➔ Place material to be scanned on scanner platen (glass surface).
➔ Click Scan button on Main Tool Bar in Kurzweil 3000, or if there is no Scan 

button on your Main Tool Bar select "Start New Scan" under the Scan Menu.
(NEVER try to scan using a scan button on the scanner!)

➔ Wait for document to scan and show up on-screen in Kurzweil 3000.

3.  Working On-screen With Teacher Prepared Material
➔ Kurzweil 3000 normally orients paper correctly (right side up).  If it fails to do so, 

select “Rotate” under the “View” menu.  Then choose “Right”, “Left”, or “Invert” 
to correct the page orientation:

➔ To write (type) on the page that you have scanned to the computer screen, add 
a “text note” by clicking the text note icon on the Study Skills tool bar
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➔ The text note will appear wherever you click on the page.  If a cursor is flashing in the 
empty text box, you can begin typing there.  The text box will expand as you type into 
it.  If the text note becomes a solid orange box, click in it and then begin typing. To 
reposition a text box, just click on it and drag it (while continuing to hold the left mouse 
down) to the spot on the page where you want it.

➔ In order to add text boxes, you have to click somewhere on the screen outside a text 
box before clicking on the Text icon.

The illustration below shows a worksheet with three text boxes.  One has a cursor 
flashing in it, and the other two are solid orange boxes.  

➔ You can type directly into a text box.  
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➔ Or, you can copy and paste into a text box.

➔ For example, to copy a definition from the Kurzweil Dictionary, select the word 
for which you want a definition.

➔ Then click on the “Definition” icon on the Main Tool bar.

➔ When the definition dialog box opens, highlight the definition by putting the cursor at 
the beginning of the definition and then holding down the left mouse button while you 
drag the cursor over the rest of the definition.   Then hold down the Ctrl key and type C 
(or go to the Edit menu and click “Copy” or copy in any other way that you normally 
copy) 
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➔ Close the Definition dialog box by clicking on the red X in the top right corner.  Then 
click inside the text box where you want to paste the copied definition.  Hold down the 
Ctrl key and type V (or paste in any other way that you normally paste).  In the 
illustration below, the definition has been pasted into the appropriate text box.

➔ Text can also be selected, then dragged and dropped into a text box.

➔ Select the text to be entered into the text box by left-clicking at the beginning of 
the text, then hold down the left mouse button down while dragging the cursor to 
the end of the text to be highlighted.  When you let go of the left mouse button, 
the text will be highlighted.  If you are highlighting a single word, you can do so 
by double-clicking on the word.

➔ Once the text is highlighted, put the cursor into the selected text and hold down 
the left mouse button.  While holding down the left mouse button, drag the the 
little “envelope” that appears and drag it until the cursor is inside the text box. 
Then release the left mouse button.
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NOTE:  You may need to change the characteristics of text that is entered into a 
                text box.  You can change the font, size, colour, etc.  When you make a change, 

     however, the changes will apply to all text boxes in the file.  Changing note options 
     is easy.  

➔ Right-click on a note to open the dialog box shown below

➔ Left-click on “Note Options” to open the Note Options dialog box shown below. 
The right side of the box applies to Text Notes while the right side is for Sticky 
Notes.
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➔ Make changes such as those shown on the left below. Then click Apply.  This will open 
the dialog box shown on the right above.  Click Yes if you want the changes to apply to 
all text boxes in the document and in all subsequent files you create.  You will then 
need to click OK on Note Options dialog box, then Yes in the dialog box shown below 
right. 

➔ Your text note, as well as all other text notes, should now look as follows:

NOTE:  Sticky Note settings are changed in exactly the same way, using the left side of the 
Note Option dialog box.
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Fill in the Blanks Tool
There is a shortcut for putting Text Boxes on all the blanks on a scanned page.  Click 
on the Tools Menu, and then select Fill in the Blanks.  A Text Box will be placed 
wherever there is a straight blank line on the page.  



4.  Scanning Text Books, Novels, and other Publications

➔ Make sure the scanner is connected to computer before opening Kurzweil 3000.
➔ Open Kurzweil 3000. 
➔ Place material to be scanned on scanner platen (glass surface).
➔ Click the Scan button on Main Tool Bar in Kurzweil 3000.

(NEVER try to scan using a scan button on the scanner!)

➔ Wait for the page to scan and show up on the screen in Kurzweil 3000

➔ After scanning the first page of your document, be sure to save your work.

➔ Click the Save icon on the Main Tool Bar  

➔ When the dialogue box shown below opens, type a name for your file and click 
the Save button beside the name you've given your file.

By default, Kurzweil 3000 saves all files to a folder entitled "Kurzweil 3000" which is 
found inside another folder called "Kesi".  The Kesi folder is placed inside "My 
Documents" when Kurzweil 3000 is installed on your computer.  You may make as 
many folders as you wish inside "Kurzweil 3000".
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Please note when scanning...

Note 1:  If scanning a multiple-page document, follow the above steps for each subsequent 
   page.  When you click the Save button on the Main Tool bar after scanning additional 
   pages, the new pages will simply be added to the end of your file.

   The Reading Tool bar shown below indicates that you are on page 2 of a 6 page 
   document.

Note 2:  If you need to rescan a page, you can do so as follows:  

➔ make sure that the page you wish to re-scan is on the screen
➔ open the Scan menu and select "Rescan Page"

➔ the page will be rescanned, and the original scan will be replaced.

➔ You can also use the Scan menu in a similar way to insert or delete a page.
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5.  Reading Scanned Material

➔ With the document you wish to read open in Kurzweil 3000, place the cursor at the 
point where you wish to hear the text read aloud to you.   Then click on the Read icon 
on the Main Tool Bar.  As Kurzweil begins reading the selected text, the Read icon will 
become a Pause button so that you can stop the reading and then begin again where 
you leave off.
 

➔ If you wish to change the reading rate, you can increase or decrease the words/minute 
by clicking the up or down arrow on the Reading Tool Bar

➔ If you wish to adjust the size of the text on the screen as you follow the text that is 
being read, you can zoom in or out by clicking the up or down arrow on the Reading 
Tool Bar

becomes
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6.  Using Basic Study Aids With Scanned Material

6.1  Sticky Notes and Text Notes

➔ To add a sticky note to a scanned page, click on the Sticky icon on the Study Skills 
Tool Bar

➔ Then click on the screen wherever you want the note to appear, and a sticky note will 
appear with a flashing cursor inside.  You may now begin typing inside the note.  The 
note will expand to include as much text as you put into it.  If you press the “Enter” key, 
the text you type will continue on a new line.

➔ Text notes can be added in exactly the same way.  Text notes have a transparent 
background so you can see through them to whatever is on the page behind.
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➔ Sticky Notes and Text Notes can be repositioned and placed wherever you want on a 
scanned page by dragging the cursor over the note until a cross appears.  

➔ When the cross appears, hold the left mouse button down and move the mouse until 
the note is where you want it to be.  When you release the mouse button, the note will 
remain in the new position.

➔ To delete a sticky note or a text note, click inside the note to select it.  Then click the 
“Delete” icon on the Study Skills Tool Bar

➔ Click yes when asked if you want to permanently delete the selected note.
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6.2  Highlighting and Extracting Text

➔ On the Study Skills Tool Bar there are four colours of highlighters.

➔ To highlight text, click on the color of your choice.  The cursor becomes a “highlighter”. 
Move the highlighter to the beginning of the text that you wish to highlight.  While 
holding down the left mouse button, drag the highlighter over the text to highlight it. 
Release the mouse button when the entire selection is highlighted.

➔ On the Study Skills Tool Bar, there is an “Erase” tool you can use to erase highlighting.
➔ Use the erase tool in exactly the same way as the highlighter pens.

➔ You can “extract” highlighted text and/or notes from scanned material into a separate 
file.  For example, you may wish to highlight the main ideas in a passage: so that you 
can review them later.  
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➔ To extract the text that you have highlighted, open the File Menu and select “Extract". 
When the Extract Box opens, select Highlights and then select the colours of the 
highlights that you wish to extract.  Click the OK button at the bottom of the box.

➔ A new window containing your extracted highlights will open.  While this window is 
open, it can be saved as a separate file by selecting “Save As” under the File Menu. 
You can use the erase tool to erase the highlighting in the new file, and you can edit to 
make any other changes that you want in the new file.

➔ Text Notes and Sticky Notes can be extracted from scanned material in the same way.
➔ You may save the new file containing the extracted information in the same way in 

which you normally save files.
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7.  Writing With Kurzweil 3000

➔ Kurzweil 3000 is not intended to be a full featured word processor.  

➔ Even though it is not really a word processor, Kurzweil 3000 can be used as a powerful 
writing tool.  You can use Kurzweil 3000 to write and then have it read your writing 
back to you so that you can hear what you have written for editing purposes.

➔ In order to use Kurzweil 3000 for writing, click on the “New” icon on the Main Tool Bar

➔ This will create a new text document, and you can begin typing into it.  (A text file is 
different than an “image file” that is created when you scan into Kurzweil 3000.)

➔ To listen to what you have written, put the cursor where you want Kurzweil to begin 
reading and click the “Read” icon on the Main Tool bar

➔ When you save what you write in Kurzweil 3000, it will be saved in a format that can be 
opened by a word processor such as Microsoft Word.  Just open your word processor, 
then find the file you wrote in Kurzweil 3000 and open it in the word processor.
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8.  Using The Zone Editor 

➔ When you scan material into Kurzweil 3000, you may find that it does not read blocks 
of text on a page in the correct order.  To fix this problem, you must use the Zone 
Editor.

➔ Open the Scan Menu and select "Zone Editor".

➔ Turning on the Zone Editor, will enclose the blocks of text on the page in boxes and the 
numbers above the boxes indicate the order in which the "zones" will be read by 
Kurzweil 3000.  This is illustrated on the following page.

➔ The Zone Editor allows you to rearrange the order in which the blocks of text are read, 
to eliminate text that you do not want to have read, and to make other adjustments.  If 
you wish, you can delete all of the reading zones made by Kurzweil 3000 and create 
your own by starting from scratch.
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➔ Select a zone by left-clicking on it.  This will open a dialogue box that gives your editing 
options.

➔ If there is a block of text that you do not wish to have Kurzweil read, select "Delete 
Zone".  If you wish to adjust the size of a zone, choose "Adjust Zone".  If you wish to 
change the order in which zones are read, select "Properties".  To start from scratch, 
or add a new zone, select "Add Zone".  You may also turn off the Zone Editor.
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➔ In the example below, all zones will be deleted so that one new zone can be 
created.  This will enable Kurzweil 3000 to do a better job of reading across the 
line.

➔ After all the zones have been deleted, right click anywhere on the page to re-open the 
Zone Editing options.  Then select "Add Zone".

➔ When the cross appears, hold the left mouse button down and drag down and toward 
the right to create the new zone.  When you let go of the mouse button, you will have a 
new zone on the page.  
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➔ This new zone can be moved and/or resized in the usual way in which boxes are 
moved and resized in a Windows environment

➔ When you have finished editing the reading zones on a page, left click on the page to 
open the Zone Editing options and click on Zone Editor to de-select it.  

➔ If you wish to keep the changes you have made, click ok when warned that your 
changes will permanently affect the document.

Note:   You cannot resume working in Kurzweil 3000 until the Zone Editor is turned off.

Prepared by Paul Hamilton
January, 2006
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